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1. Introduction 
After Product Development completes a form that will have information input electronically and will be printed out of an online 
platform, it needs to be “mapped.” Mapping a form is done so that someone using an online platform can populate a text field 
with accurate information necessary to fill out the form or check appropriate check boxes before printing the form out. Having 
information typed into the form helps us, our clients, and their customers save time and it makes documents more readable. 
When a form is mapped and filled out properly, we are able to administrate contracts much more efficiently because the 
information that the client enters into the form is sent to our databases, eliminating the need for printed copies of contracts.  
 
The mapping process consists of adding text fields and check boxes, known collectively as “form fields,” to the PDF version of a 
document. Currently, the mapping system in Toro supports only two types of fields: simple and complex fields. A text field is an 
example of a simple field, but not all text fields are simple fields. A check box is an example of a complex field (for more 
information about simple and complex fields, see Sections 3.B., 3.C., and 4.B.). Toro is designed to interact with simple and 
complex fields that follow very specific naming syntaxes. If a text field or check box is not named properly, the mapping for that 
field will not function. An example of what a form will look like when properly mapped is provided below. 
 

 Before Mapping After Mapping 

   
 
This Technical Training Bulletin will show you which tools and documents you need to map a form, how to map automotive 
forms before and after uploading them to Toro (see the “UPLOADING FORMS TO TORO” Technical Training Bulletin regarding 
uploading forms to Toro), how to use a rate ID to help you map a form correctly, and how to map home warranty forms. 
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2. What is Needed to Map a Form 
To map a form, you will need the materials and programs listed below: 

x The finalized PDF version of the form you are mapping 
x The rate IDs that correspond to the form that you are mapping (Underwriting should provide these to you) 
x Access to the Plan Code Tables Excel spreadsheet, which contains all of the field names and descriptions supported by 

Toro. If you do not have this spreadsheet, you can request a copy from the IT department. 
x Microsoft Excel 
x Microsoft Word 
x Adobe Acrobat X Pro (this Technical Training Bulletin uses version 10.1.3 in all examples)  
x Toro v.3.0.7 (this Technical Training Bulletin uses v.3.0.7 running on Windows 7 Professional) 

3. Process for Automotive Forms 
The processes listed below will show you how to add form fields, edit simple and complex field properties, use the rate ID to 
determine appropriate ID numbers for complex fields, prepare a form for mapping after it has already been uploaded to Toro, 
and request new fields from the IT department. Please take note of all red markings on screenshots throughout this bulletin, as 
they show important information. 

A. Adding Form Fields 
1. Open the PDF version of the form in Adobe Acrobat X Pro. 
2. Click the Tools button in the toolbar and click the Forms drop-down list box. NOTE: the location of all buttons and 

menus may vary depending on which version of Adobe Acrobat Professional is installed on your computer. 
 

 
 
3. Click Edit. If you will be mapping forms often, you should add a toolbar shortcut for the edit button by right 

clicking Edit and selecting Add to Quick Tools. This will allow you to skip the previous step. NOTE: depending on 
what version of Acrobat you are using, there may not be an Edit option.  
 

 
 
4. The Add or Edit Form Fields dialogue box will appear with the following prompt: “Currently there are no form 

fields in this PDF. Do you want Acrobat to detect form fields for you?” Click No.  
NOTE: If you click Yes instead of No, Acrobat will automatically place text fields and check boxes in the places it 
believes they should be placed. If you allow Acrobat to place text fields and check boxes, you must delete any extra 
form fields that you do not need (e.g. a text field for the signature line). 
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5. Determine whether you will need to use a text field or a check box for the section you are mapping. To do this, you 
must consider the function of the field you will be mapping. If a field will have text or numbers displayed in it (e.g. 
the name of a customer or dollar amount of the contract price), then use a text field. If the field needs to show a 
binary value (e.g. yes or no), or to select a certain option (e.g. coverage type selected or surcharges), use check 
boxes. See below for examples of the types of fields in which you would place text fields and check boxes. 
 

Text Fields Check Boxes 

  
 
6. Under the Tasks list, click the Add New Field drop-down list. For the purpose of mapping a form, you should click 

only either Text Field or Check Box. You may also right-click anywhere in the document and select the field type 
you need from the list box that appears as shown below. 
 

 
 

7. Once you select the type of form field you want to insert, a set of blue crosshairs will appear where the cursor is 
pointing. Click and drag the cursor to draw the form field in the appropriate section of the form. Each text field and 
check box should fill the area where you place it as completely as possible without overlapping the borders or any 
text that happens to be in that field. See below for examples. 
 

Text Fields Check Boxes 

  
 

8. Repeat Steps 5, 6, and 7 until you have inserted all form fields for all of the necessary areas of the form.  
9. To make the text fields and check boxes function correctly with Toro, you must edit their properties. To access 

these properties, double click the text field or check box. If you want to edit properties as you create form fields 
(before creating a new form field), click the All Properties hyperlink, which is blue and underlined. See Sections 
3.B., 3.C., and 4.B. for more information on how to edit properties of form fields. 
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B. Editing Text Field Properties as Simple Fields 
Simple fields are form fields that display information input from online platforms in text form (e.g. the customer’s 
name, the dealership’s address, or the VIN of a vehicle). As of the time of this writing, only text fields are simple fields, 
so this section will use text fields in these examples. To edit the properties of simple fields, complete the steps below. 
1. Open the current Plan Code Tables spreadsheet in Excel.  
2. Click the FormFields tab if the spreadsheet did not open directly to the FormFields sheet.  
3. Use the information in the Descriptions column to help you select the appropriate name from the 

FormFieldPrefix column. Note that the IsComplex column reads as “False” for simple fields. Text field names 
always begin with the prefix txt. The form field should be named exactly as it is listed in the FormFieldPrefix 
column on the Plan Code Tables. No extra characters should be written into the Field Name. 
 

 
 

4. Set the properties for the text field you inserted in Section 3.A. as illustrated below (NOTE: If an option in the Text 
Field Properties window is not mentioned specifically, it may be disregarded.): 

a. Under the General tab: 
 

 

Type the appropriate 
Form Field Prefix exactly 
as it is listed in the Plan 
Code Tables. 

 

Under the Form 
Field drop-down list, 
click Hidden but 
printable. 

 

Select the Read Only 
checkbox. 
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b. Under the Appearance tab: 
 

 
 

c. Under the Options tab: 
 

 
 
  

Under the Font Size 
combo list, enter 10. 
Enter Auto if the text 
box is very large or 
small, or you think the 
information will not fit 
with size 10 font. 

 

Under Border Color and 
Fill Color, click No Color. 

Under the Text Color 

group box, click Black.  

 

Leave the Alignment as 
Left unless the formatting 
of the form requires Right 
or Center alignment. 

 

By default, the Check 

Spelling option should 
be selected. Select the 
Check Spelling check 
box to disable the spell 
check option. 

 

Under the Font drop-
down list, click Helvetica. 
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d. Under the Format tab: 
If the text field is a date 

 
 

If the text field is a number 

 

Under the Date Options 

list, click mm/dd/yyyy. 

 

Under Decimal Places, 
click 2. 
 

Under Separator Style, 
click 1,234.56. 
 

Under Currency Symbol,  
click None, unless the 
number is a dollar 
amount. In that case, click 
$ and under Symbol 

Location, click Before with 

space.  
 

For most number-related 
fields, click Number. 
NOTE: Most contracts that 
you map for use in Toro 
will have a section for a 
contract number. Do not 
select Number for the 
contract number text field. 
Under Select format 

Category, click None for 
the contract number field. 
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5. Click Close after editing all of the above listed properties for the simple field. 
6. Edit all the properties of all the simple fields in the form as shown in Step 4. Every simple field should have a different 

name selected from the Plan Code Tables spreadsheet that corresponds with the intent of that section of the form. 
7. Under the File menu, click Save As, and then click Reduced Size PDF…. The Reduce File Size window will appear. 
8. Under Make compatible with:, click Acrobat 5.0 and later. Doing this reduces the likelihood of any errors or 

glitches occurring when someone using an older version of Adobe Acrobat attempts to open the file.  
 

 
 
9. Click OK. The Conversion Warnings window may appear; if it does, click OK. 

 

 

C. Editing Text Field Properties as Complex Fields 
While simple fields are always text fields, not all text fields are simple fields. Non-simple fields are called Complex 
Fields. The only difference between simple and complex text fields is the naming structure in the properties (all other 
properties as shown in Section 3.B. remain the same for complex text fields). The naming structure of complex text 
fields includes more information than simple text fields. The additional information is shown using ID numbers, which 
are one to three digit numbers that represent many different programs, terms, coverages, and other information found 
in the Plan Code Tables spreadsheet. Name complex text fields using the following structure: (for this example, we 
will map the term months from form BNV-XX-XX-01 shown below): 
 

 
 
1. Text field names always begin with the prefix txt. Because we want to include the New subprogram and term 

months, the text field name will be txtSubProgramTermMonths, which is listed under the FormFields tab of the 
Plan Code Tables. 

2. Use a colon (:) to separate the text field name from ID numbers. 
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3. Find the appropriate ID numbers under the Subprogram tab in the Plan Code Tables. See Section 3.E. for more 
information on choosing ID numbers. 

4. Add all appropriate ID numbers after the colon. Separate ID numbers with a comma (,) with no spaces between 
the ID numbers. In this example, the ID numbers correspond with the New subprogram (subprogram ID 1) and the 
Wrap subprogram (subprogram ID 12). 

5. The full name for the complex field in this example looks like this: txtSubprogramTermMonths:1,12 
6. Edit all other properties for text boxes as shown in Section 3.B.. 

D. Editing Check Box Properties as Complex Fields 
In addition to text fields, complex fields can also be used to display information in check boxes. Check boxes have a 
binary status, rather than indicating text or numbers. Either the option that the check box represents is selected or it is 
not. For this example, this bulletin will show the process mapping a check box to show the subprogram, coverage, and 
term of a program. 
1. Open the Plan Code Tables in Excel if you do not already have it open.  
2. Click the FormFields tab if you are not already working in the FormFields sheet.  
3. Select the FormFieldPrefix from the FormFields tab that corresponds to the check box you want to map. You can 

use the descriptions to help determine which FormFieldPrefix is appropriate. Note that the IsComplex column in 
the Plan Code Tables reads as “True” for complex fields. If a form field does not say “True” in the IsComplex 
column, then you cannot use it as a complex field. 

4. Open the PDF version of the form you are mapping if it is not already open.  
5. Double click the check box whose properties you want to edit. The Check Box Properties window will appear. If 

you do not already have a check box in place, see Section 3.A. for more instructions on how to add a check box. 
6. Name check boxes using the following structure: (for this example, we will map the check box that corresponds to 

the New subprogram with Comprehensive coverage from form BNV-XX-XX-01 shown below): 
 

 
 

a. Check box names always begin with the prefix chk.  
b. Because we want to include the subprogram and coverage as conditions for this complex field, the check 

box name will be chkSubprogramCoverage. This name is listed under the FormFields tab of the Plan 
Code Tables (at the time of this writing, it is the 32nd FormFieldID). The name MUST be written exactly 
as shown above, or it will not function in Toro. 

c. Find the appropriate ID number under the tab that matches the type of information you intend have the 
check box indicate in the Plan Code Tables (e.g. if you are mapping a check box for coverage, click the 
Coverages tab). See Section 3.E. for more information on this step. 

d. Use a colon (:) to separate ID numbers from the form field name. 
e. Add all appropriate ID numbers after the colon. See Section 3.E. for more information about determining 

the appropriate ID numbers to use. There are a few ways to input this information: 
i. Separate ID types (e.g. subprogram ID and coverage ID) with colons (no spaces). E.g.: 

chkSubprogramCoverage:1:4 indicates the New subprogram (subprogram ID 1) and 
Comprehensive coverage (coverage ID 4). 

ii. Separate ID numbers corresponding to the same condition with commas (no spaces). E.g.: 
chkSurcharge:13,14,121 indicates the surcharges listed here: business use for passenger 
vehicles (surcharge ID 13); business use for trucks, vans, mini-vans, and SUVs (surcharge ID 14); 
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and commercial use (surcharge ID 121). All of these ID numbers correspond to the Commercial 
Use surcharge, so they all should be input to the name of the check box. 

iii. If multiple values will make the condition true, group them together with parentheses.  
iv. Use the symbol ~ to indicate that all values that are NOT in the preceding list (grouped with 

parentheses) will make the condition true. 
f. The full name for the New (subprogram ID 1) Comprehensive (coverage ID 4) check box in this example 

looks like this: chkSubprogramCoverage:1:4. 
7. Set the rest of properties for the check box you inserted in Section 3.A. as illustrated below (NOTE: If a field or 

option is not mentioned specifically, it may be disregarded): 
a. Under the General tab: 

 

  
 

b. Under the Appearance tab: 
 

 
 
  

Type the appropriate 
FormFieldPrefix exactly 
as it is listed in the Plan 
Code Tables, then add 
ID numbers as shown in 
step 6. 

 

Under the Form Field 
drop-down list, click 
Hidden but printable. 

 

Select the Read Only 
checkbox. 

 

 

Under Border Color, click 
Black. Under Fill Color, 
click No Color. 

 
Under Font Size, click 
Auto. You MUST do this 
for the check box to 
populate correctly. 

. 

 

Under Line Thickness click 
Thin. Under Line Style, 
click Solid. 

 

Under Text Color, click 
Black. 

 



Technical Training Bulletin 

 

TTB #: FMB-XX-XX-07 

EFFECTIVE DATE: 09.06.13 

LAST REVISION: 12.16.13 

PAGE: 11 of 22 MAPPING FORMS 

 

c. Under the Options tab: 

 
 

8. Click Close. 
9. Repeat Steps 5-8 with the other check boxes until you complete editing the properties for all the check boxes you 

need to map. 
10. Under the File menu, click Save As, and then click Reduced Size PDF…. The Reduce File Size window will appear. 
11. Under the Make compatible with: drop down list, click Acrobat 5.0 and later. Doing this reduces the likelihood 

of any errors or glitches occurring if someone using an older version of Adobe Acrobat attempts to open the file. 
 

 
 

12. Click OK. The Conversion Warnings window may appear; if it does, click OK. 
 

 
 

13. After mapping text fields and check boxes into the form and saving it, you are now ready to upload the form to 
Toro. Please see the “UPLOADING FORMS TO TORO” Technical Training Bulletin for more information.  

Under Check Box Style, 
click Square. 

 
Under Export Value, type 
Yes. Make sure to use a 
CAPITAL Y. 
 


